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supplies, or toiletries.  

MIX AND MATCH SEWING WITH OLIVER + S

6 The Oliver + S children’s patterns are very fun and easy to follow. A few changes to 

the patterns make an outfi t that looks like one from a pricey children’s boutique. 

PIN CUSHION ANGEL

10  Let this lovely pin cushion angel watch over your sewing adventures, and she’ll bring 

you happiness and success!

SPLASH HAPPY

13  ReadyMade and BERNINA have partnered up to bring you this squeaky clean and 

super cute shower curtain sewing project to add some pizzazz to your bath. 

WHAT’S IN YOUR CLOSET?

14  The projects on these pages feature a variety of techniques that you can use to 

upcycle what may be languishing in your closet. Learn how to turn it into a unique 

fashion statement for you or your home!

NEVER SAY “NEVER”

16  Wendy Sheppard loved the look of Baltimore Album quilts, but was content to 

admire them from afar until she learned how to sew at her local BERNINA store. 

HOPE, LOVE, AND PEACE HOODIE

20  Hooded sweatshirts with raw-edge appliqué are a popular trend. This appliquéd 

hoodie is a great way to showcase your creativity and ingenuity and have fun with 

fashion! 
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24  Sometimes the challenge of fi nding just the right color and size cord to couch can 

be a challenge, but it’s easy to create the cord you want for your project using your 
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27  A gift of fl owers lasts even longer when presented in this lovely decorated basket. 

Insert a greeting card or note into the pocket to express your sentiments. 

EMBROIDERY ON THE UNUSUAL – PART 1: ALUMINUM DRINK CANS HOT PAD
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recyclable drink cans!

10 REASONS YOU LOVE MY LABEL 3D FASHION PATTERN SOFTWARE

30  Why do YOU love My Label software? Here are a few of your favorite things about 

this unique garment pattern software. 

STITCH RECIPE: 830 DIRECTIONAL DELIGHT!

32  What makes the 830 directional stitching stand out from that of previous models? 

The connecting stitch screen – there’s no longer any need to fi gure out the movement 

using a compass. 

BLACKWORK BOOKMARKS

34 These fancywork bookmarks make great last-minute gifts. Keep one or two for 
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needle notes
Spring and summer bring many occasions for gift giving – Mother’s Day, Father’s

Day, and school graduations. This issue of Through the Needle has many small

projects that make ideal gifts. Check out the embellished “Flower Power” fl ower

basket (page 27) from our BERNINA friends in Switzerland and a delightful

Pin Cushion Angel designed by elinor peace bailey (page 10). Perhaps a pair of

blackwork bookmarks (page 34) or a cute little purse (page 4) is the perfect thing to

sew for someone on your gift list.

Then there’s upcycling, a new name for an old concept. Learn some fun ways to

reuse worn or dated items and turn them into new, useful creations. “Going green”

is not only popular, but smart – and an important investment in our ecological

future. You’ll fi nd several ways to upcycle old clothing in this issue, from turning

men’s old jackets into a cute new suit or a cozy throw (page 14) to embellishing a

plain hoodie and turning it into a fashion statement. In the mood for something

totally different? How about machine embroidery on recycled soda cans (page 28)?

If you have a new 830 you’ll fi nd articles written specifi cally for you, including a

terrifi c stitch recipe (page 32) and a black-and-white designer pillow (page 22).

If you don’t own an 830, don’t worry – there’s plenty more for you in this issue,

including instructions for recreating the 830 stitch recipe on your machine. Love

couching, but hate searching for the perfect cord? Make your own following Jane

Garrison’s serger “recipe” on page 24.

If you love collecting sewing machine accessories, but don’t always know when

or where to use them, you’ll appreciate Nina McVeigh’s article on constructing a

sweet child’s outfi t from Oliver + S. Learn to use Bias Binder #84 with Foot #94,

Edgestitch Foot #10/10C, Button Sew-On Foot #18, Open Embroidery Foot #20/20C,

and more (page 6). And, last but certainly not least, fi nd out how Wendy Sheppard

overcame her frustration with free-motion quilting using the BERNINA Stitch

Regulator (page 16).

There’s something for everyone here – plenty to keep you stitching to your heart’s

content for the sunny months ahead.
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Artgirlz Monographs

Isacord Embroidery Thread

Fast, Fun and Fresh One-Day Projects

Spring is the perfect time to add a bit of light and liveliness to your days. Colorful, 

dynamic projects are only a day away, and it’s all possible because of perfectly 

simple patterns and fabulous supplies from Brewer Quilting & Sewing! With 

illustrated instructions, colorful threads, cool fi bers and embellishments, and 

a Bernina Stitch Regulator, your free-motion embroidery is sure to come out 

top-quality. You’ll be adorning your home with cool artwork or giving handmade 

treasures as gifts in no time. 

Monographs from ARTGIRLZ

Get one fabulous project in each little booklet! The wonderful, whimsical Artgirlz 

provide complete, color-illustrated instructions and a short list of supplies to 

get you from start-to-fi nish in just a few hours. Add great threads and other 

embellishments to selections from your scrap stash to create a Nine-patch mini-

quilt with a fl air for fun, a reversible patchwork tiara to make you queen for a day, 

or a fi ne and fancy treasure box to hide away your secrets. One-day projects have 

never been so easy.

Polyester Thread from ISACORD

Measure the quality of every other thread by Isacord threads! Trilobal polyester 

creates a beautiful sheen, the dye lots are perfect and never over-dyed, and 

superior tensile strength reduces fraying and breakage. Isacord polyester threads 

will put strength, color, and shine into your one-day projects.

Pewter Charms from ARTGIRZ

The Artgirlz provide pizzazz to help you embellish your one-day projects. Attach a 

tiny crown fi t for a princess (1" x ½"), or add a bit of personality with a cheeky face 

(1" x ¾"). Both charms are lead-free and made in the USA.

Button Bonanza from Buttons Galore 

Embellish your one-day projects with batches of buttons you can order in sets 

of any variety—spring colors, vintage colors, all reds, or all pinks for example. 

Buttons Galore offers 15 Button Bonanza batches to satisfy any whim and any 

project. Each reusable plastic 

container comes with about a 

half pound of buttons sized 
3/8" to 1" diameter. 

Millies – a Brewer Exclusive

Show off your sense of style 

by incorporating high-quality, 

creative embellishments on 

your projects. Add texture and 

interest with Millies, beautiful 

collections of creative fi bers. 

Each collection contains two 

yards of 15 different yarns. 

Choose your set of colors 

and styles, with options such 

as Garden Carnivale, Blue 

Meadow, or Spring in the 

Forest. Make those project 

details count!

spotlight on…

Artgirlz Mini Charms

Buttons Galore
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This simple one-piece bag 
is fun to make and can be 
used for cosmetics, sewing 
supplies, or toiletries.

CENTER PANEL
1. Bond the stabilizer to the wrong side of 

the center panel using basting spray. 
Fold the panel in half lengthwise and 
fi nger press to form a crease. Thread 
the machine with a contrasting color 
and attach the all-purpose foot. Select 
a decorative stitch and sew it down the 
center of the panel, using the crease 
as a guide. Tip: Using a clear foot gives 
more visibility and makes it easier to 
follow the crease.

2. Attach the seam guide to the presser 
foot and set it for 5/8". Select a second 
decorative stitch and sew a line on 
each side of the center using the seam 
guide for spacing. When the stitching is 
complete, carefully remove the stabilizer 
from the back.

BY SUSAN BECK

SUPPLIES
• Coordinating Fabrics:
    - Bag: 10" x 14"
    - Lining: 10" x 14"
    - Center panel: 3" x 14"
    - Trim: Two 1½" x 14" pieces
    - Bias Binding: 1½" x 60"
• Batting, 10" x 14"
• Thread (may be the same)
    - Color to contrast with front panel
    - Color to blend with bias binding
• OESD tear-away stabilizer, 

3" x 14"
• 101 Quilt Basting Spray
• Two decorative buttons
• Presser Feet:
    - All-purpose with seam guide
    - Edgestitching foot
    - Free-motion foot

Finished size: 
Approximately 8" x 6 ½"

Flat Fold Over Bag



5

I S S U E 3 0

OUTER BAG
3.  Layer the bag fabric over the batting and use basting spray to

hold them together. Spray the back of the center panel and
center it along the length of the bag fabric.

4.  Fold the trim strips in half lengthwise with wrong sides facing
and press. Position the raw edges of one folded strip along one
raw edge of the center panel. Stitch in place ¼" from the raw
edges. Press the strip over the raw edges, away from the center
panel. Select the blanket stitch and sew along the seam. Using
an edgestitch foot, sew the outer edge of the strip in place.
Repeat with the remaining strip on the opposite edge of the
panel.

5.  Lower the feed dog of the machine. Using a free-motion presser
foot, stipple-quilt the fabric layers on each side of the center
panel.

LINING
6.  Use basting spray to adhere the bag fabric (batting side) to

the lining wrong side. Chalk-mark a stitching line across the
center of the layered fabric rectangles. Raise the feed dog
and attach the all-purpose foot to the machine. Stitch
across the center of the layered rectangles.

7.  Position the pattern on the prepared bag fabric, aligning
the centerline of the pattern with the centerline of
decorative stitching on the bag. Cut out the bag.

BINDING
8.  Fold the long edges of the bias strips to the center of the

wrong side and press. Tip: Use a bias tape maker to hold
the strip while pressing.

9.  Unfold the bias tape and stitch it to the bag, aligning the raw
edges. Start and end at the center of one long edge of the bag.
Fold the tape around the edge and stitch in place, sewing along
the edge of the binding.

FINISHING
10.  Fold the bag in half across the width using the stitching from

Step 6 as a guide. Stitch along each side, starting at the folded
edge and sewing for about 4".

11.  Cut an 8” length of bias tape for the loop. Fold the long edges
in to the center and press. Stitch the folded edges together.
Position it on the bag where  indicated and bartack in place.
Sew one button on top of the bartack, hiding the raw edges
of the loop. Sew the second button on the bag front in a
corresponding position. Place the loop over the front button to
close the bag.

Using specifi c presser feet can make sewing techniques easier to
stitch and the results more professional. The following BERNINA
presser feet can be used to make this little bag.

Clear Foot
#34/34C – Steps
1, 2, 3, 6, 8, 9, 10

and 11

Edgestitch
Foot #10/10C –

Step 4

Quilting Foot
#29/29C –

Step 5

Photocopy
at 200%
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Oliver + S
BY NINA MCVEIGH

The general construction of these garments is simple and easy; 
just follow the detailed and well-written pattern instructions. The 
following directions are for adding special details and perfecting 
techniques using specially designed presser feet.

Add the Bands
Using a coordinating fabric to create the contrasting waistband 
and bottom bands to add a special detail to the pants. 

To add the contrasting bottom bands, trim away the hem 
allowance at the lower edge of the front and back pattern pieces 
before cutting the pants pieces from the fabric. 

To add a band of the fi nished width shown (1¼"), that means 
trimming away 1¾" at the bottom of each front and back leg.

Measure the lower edge of the pant front and back legs and cut 
a 3¼"-wide strip for each band.

To attach the band, measure and mark a line 1" from the lower 
raw edge of each pant leg. Turn under and press ½" along one 
edge of each band. 

Attach Patchwork Foot #37. On each pant leg, position a band 
with right sides facing and the raw edge of a band along the 
drawn line; pin in place. 

Place under the foot so the edge of the foot is even with the 
raw edge of the contrasting strip. Stitch ¼" from the raw edge. 
Press the band toward the lower edge of the pants leg. Turn the 
band to the wrong side so that the folded edge just covers the 
stitching line and press before opening out again. 

Add the Appliqué
While looking at the fabric for the blouse, I found the perfect 
shapes to imitate for simple appliqués that visually tie the 

pants to the blouse.

To make similar appliqués, draw simple star and 
fl ower shapes on the Heat and Bond Lite and cut 
out each one, leaving a margin all around each one. 
Position on the wrong side of the fabric scraps and 
fuse following manufacturer’s directions. Cut out 

each shape on the drawn lines. 
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Remove the paper and arrange as desired on one pant leg –
notice that two overlap the bottom band. Fuse in place and then
use Open Embroidery Foot #20 and a blanket stitch with the
needle position to far right to appliqué.

Complete the Pants
Sew the leg seams. Use a serger for a great way to seam and
fi nish all in one step.

Fold the band to the
inside again and pin.
Attach Edgestitch
Foot #10/10C and
align the center guide
in the “ditch” of the
band seam.

From the right side,
stitch-in-the-ditch,
taking care to catch
the contrasting band
on the wrong side.

Finish the pants
following the pattern
instructions.

Supplies
• Oliver + S Patterns

 -  “2 + 2 Blouse & Pleated
Skirt”

 - “Sandbox Pants”

• Fabrics for chosen size
 - Floral print for top
 -  Coordinating solid for

pants
 -  ¼ yard coordinating

print for pant bands

•  Coordinating fabric scraps
for appliqué

•  Notions and interfacings as
indicated on the pattern

•  Heat and Bond Lite fusible web

•  Three decorative buttons for
embellishment

• #80 Universal machine needle

• Buttonhole cutter and block

• Machine Feet and Accessories
 - Reverse Pattern Foot #1/1C
 - Edgestitch Foot #10/10C
 - Button Sew-On Foot #18
 - Open Embroidery Foot #20/20C
 - Patchwork Foot #37
 - Bias Binder #84 with Foot #94
 - Quilting/Seam Guide

The Oliver + S children’s
patterns are very fun and
easy to work with. Make a
complete outfi t using the

blouse from one pattern and
the pants from another. A

few changes to the patterns
make an outfi t that looks like
one from a pricey children’s
boutique. Using special feet
and accessories makes the

project easier and produces
professional results.



8

T H R O U G H  T H E  N E E D L E

Make the Blouse
While the construction of the blouse is easy, you can make it 
even easier by using special presser feet and accessories. 

Begin by following the pattern instructions, but instead of cutting 
the neckband strips, cut two pieces of bias 11/16" x the length of 
neckband + 2". Use the Bias Binder Attachment with Foot #94 
to bind the neck edge. This is an easier, more professional fi nish 
and will save time.

Cutting open buttonholes can be tricky, so it is best to use a 
buttonhole cutter and block. Position the buttonhole over the 
wood block, align the blade of the buttonhole cutter with the 
buttonhole opening and press down fi rmly. The cutter provides 
a clean cut without the danger of cutting the threads of the 
buttonhole itself.

Sewing on buttons is faster and easier when done by machine. 
Whether functional or decorative, buttons can be attached in no 
time using Button Sew-On Foot #18. Many BERNINA machines 
have an automatic button sew-on stitch. 

When sewing 
a visible hem, 
as around the 
bottom of the 
blouse, it is best 
to sew from the 
right side. To 
perfectly place 
this stitching, 
attach the 
quilting guide 
to the back of 
Reverse Pattern 
Foot #1/1C 
and set it at the 
depth of the 
hem.

Sewing for 
children is fun, and using the feet and 

accessories available to you will make 
you look like an expert! These feet and 
techniques are all found in BERNINA’s 

Feetures Volumes 1-3.
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Directions
Angel Construction
Trace and cut out the paper pattern pieces. Fold fl esh-colored
fabric right sides together. Using the paper pattern pieces as
templates, draw around them to trace the body pieces onto the
fl esh-colored fabric. Repeat for the wings.

Stitch along the indicated seamlines using a straight stitch with
length = 1.5mm. Clip curves as indicated on the pattern pieces.

Make a small slash through a single layer of each piece,
slashing where indicated. Make sure to slash the arms in
opposite directions so there will be a left and a right and the
openings will be hidden by the body. Slash and turn the leg so
one slash will cover the other. Slash and turn the wings so there
will be a left and a right.

Turn each piece right side out with the Turn-It All. Stuff each
piece fi rmly with the Polyfi l. Close the openings by hand
with the Button and Craft Thread using the ladder stitch
(see sidebar).

Materials
• Fat quarter of fl esh-colored fabric
• 12" square of cotton velveteen for pin cushions
• ¾ yard of 2"-wide wired ribbon
• Scrap of woven cotton for wings
•  Two buttons and a few beads for pin cushion

tops
• Scrap of gold trim
• Fairfi eld Polyfi l
• #7 long darner (hand-sewing needle)
• Coats & Clark Button and Craft Thread
• Fray Check liquid seam sealant
• Turn-It All turning tool
• Barbara Willis Stuffi ng Forks
• Face painting supplies:

 -  Permawriter II 0.03 fi ne-tipped
permanent pen

 -  Brush-tipped fabric
pens

 - Crayola crayons

Let this lovely pin cushion angel watch
over your sewing adventures, and she’ll
bring you happiness and success!

Pin Cushion Angel

The Ladder Stitch (aka Slip Stitch or Hem Stitch)

To make this simple back and forth, over-under stitch,
study the illustration.

BY elinor peace bailey
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Assemble the pieces as shown in the illustrations with the #7
long darner and Button and Craft Thread using the ladder stitch.

Yo-yo Pin Cushions Construction
Using the patterns provided, cut two large yo-yos and one small
yo-yo from the velveteen. Turn under 1/8" along the outside edge
of each yo-yo, using knotted Button and Craft Thread. Draw up
the stitches to gather the yo-yo around enough Polyfi l to make
a puffy pin cushion. Bring the needle through the center of the
back of the yo-yo and pull. Return to the opening and then to the
back. Pull again. Tie off the thread.

Mount one large yo-yo, gathered side up, between the hands of
the angel using the ladder stitch. Mount the second large yo-yo,
gathered side down, between the wings. Mount the small yo-yo
on the head of the angel. Stitch it in place and surround it with
the gold trim to make it look like a crown.

“A walking
advertisement for

fun” is how someone
once described elinor

peace bailey. With
her bright clothing,

outgoing nature, and
lively sense of humor,
it is obvious that elinor

is not your “typical”
sewing teacher. A

globe-trotting teacher
of doll-making who
designs fabric and
exercises her talent
as a graphic artist

on any stray surface
she can fi nd, elinor
teaches and shares
her unique designs
for dolls, toys, and

other stuffed creations
with students all

over the world. She
writes and illustrates
a quarterly newsletter

for APWPWD – the
Association for People
Who Play With Dolls.
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Add stacked beads to the top of the
crown. Add buttons to the tops of the
larger yo-yo pincushions.

Tie the ribbon around the body of the
angel with the bow below her wings.

Copy the face using fi ne-tipped marking
pens, and then use the brush-tipped pens
to add color and the crayons to rouge the
cheeks.



Pattern designed by the editors of ReadyMade.
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What’s in Your Closet?What’s in Your Closet?
BY SUSAN BECK, JUDY HAHNER, AND VICKI TRACY

We’ve all had the experience of looking 
at a closet full of clothes and thinking, “I have 
nothing to wear!” But how about recycling 
some of the garments lurking in the back 
of your closet? Or treasures from thrift 
stores and rummage sales? The projects 
on these pages feature a variety of sewing 
and embellishment techniques that you can 
use to upcycle what may be languishing in 
your closet and turn it into a unique fashion 
statement for you or your home! 

What we’re doing is really nothing new – 
it’s been going on since long before our 
grandmothers used worn-out clothing to 
piece quilts. But what is new today is the 
artistic fl air and updated looks you see on 
refashioned clothing and home dec items. 
Also new today are some of the words we 
use to describe the process: refashion, 
deconstruct, alter, upcycle. 

Here is an idea to inspire you to look at 
things in your closet in a new way - turn an 
old jacket into a charming two-piece suit.

• Needle punch yarns and fi bers into the 
jacket collar and lapels. This is quick 
and easy using Bernina’s Needle Punch 
Accessory Set, but you can also do it by 
hand with a felting needle. 

• Couch twisted fi bers or yarn along the 
lapel and collar edges using Edgestitch 
Foot #10/10C. Place the blade along the 

edge of the lapel and the twisted fi bers on 
the other side of the blade. Use a side-to-
side stitch such as a zigzag and set it wide 
enough to stitch into the jacket and then 
swing over to encase the twisted fi bers. 

• Cut across jacket below the lapels. You’ll 
make the skirt from the cutaway lower 
section.

• Serge the layers together at the cut 
edges of the jacket and the “skirt” for 
control, then bind them with bias cut silk 
ribbon.

• Try on the jacket and tuck out excess 
room for a professional fi t. 

• To add a casing to the “skirt,” apply 
Steam-a-Seam fusible tape to one edge 
on the wrong side of an old faux leather 
or suede belt. Position on the inside of 
the skirt along the upper edge and fuse. 
Then stitch both edges to the skirt. Insert 
wide elastic into the casing formed by the 
belt for “hip-grip.”

• Try on the “skirt” and adjust the elastic to 
fi t at the desired location on your upper 
hipline. Pin the elastic in place several 
inches from the front edges of the two 
front panels. Next, determine where the 
center front will be; cut along this line 
through both left and right panels. Stitch 
the elastic in place. 

• Bind the front edges, and then insert 
a decorative zipper between the front 
panels.

• Close the vent in the center back of 
the skirt by spacing and sewing fi ve 
buttons through all layers. They’re simple 
to attach using Button Sew-On Foot 
#18 and a button sew-on stitch. If your 
machine doesn’t have a button sew-on 
program, use a zigzag or universal stitch 
with the stitch length set at 0. 

Start with a few men’s jackets fromStart with a few men’s jackets from 
the local thrift store.the local thrift store. 

A man’s suit jacket is fun to refashionA man’s suit jacket is fun to refashion 
into a chic two-piece suit. Notinto a chic two-piece suit. Not 

only do you usually have great fabric,only do you usually have great fabric, 
but the tailoring is already done!but the tailoring is already done!
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Here’s another great use for old wool suit jackets that are out 
of style but in good condition. Combine a variety of colors and 
patterns for the patchwork. 

• Cut wool into rectangles of 
different lengths.  Arrange 
in rows and serge together 
using a wide fl atlock stitch. 
Serge (fl atlock) the rows 
together to form a large 
rectangle. Use a heavy 
decorative thread such as 
YLI Monet or Success.

• Using the same thread as for 
fl atlocking, serge the outer edges of 
the throw using a wide three-thread 
overlock stitch.

• Needle-punch designs as desired: 
Create stylized fl oral designs or 
simply add color by punching 
abstract shapes (swirls, dots, 
stripes, etc.) into the wool.

Transform warm and wooly thrift-store finds into a snugglyTransform warm and wooly thrift-store fi nds into a snuggly 
throw for watching TV on chilly nights.throw for watching TV on chilly nights.

Resourceful Thrifting
Once you catch the re-fashion bug, you’ll soon run 
out of “before” options in your own closet. A great 
place to fi nd items to deconstruct/reconstruct is your 
local thrift store. If you look, you’ll probably fi nd several 
resale and consignment shops in your area. Log on to 
www.thriftshopper.com for resale shops near you. 

When shopping for gently used clothing, keep 
the following in mind:

• All resale shops are not the same. You may fi nd 
resale stores that are more upscale than some 
retail shops! There are also others that are little 
more than dumping grounds for unwanted 
wardrobes but may offer the best bargains. Don’t 
rule out either; after a visit or two, you’ll know if it’s 
worth your time and effort to make return visits.

• Be prepared to spend more time than money 
when thrift-store shopping. It may take awhile 
to fi nd the perfect pieces for your next project. 
Think of thrift-store shopping as an adventure or a 
journey and not a quick in-and-out, “pick up what 
you need” errand.

• Keep an open mind when looking at others’ 
castoffs. Be creative and think outside the box as 
you consider the new life each garment might have. 
Turning a man’s shirt into a funky apron or a felted 
sweater into a cozy pillow may not be obvious at 
fi rst glance. Don’t look at an item as a whole but 
isolate parts of it, imagining the center back fl at-
felled seam of a shirt on the front of a purse or 
considering the pockets from a garment for pieces 
of a quilt. Anything is possible once you imagine it.

• Look for quality garments that can withstand the 
stress of being pulled apart and reworked. Good 
fabric, strong details, and interesting fi ndings will 
look good no matter how they are used.

• Check fi ndings and closures on every garment. 
You may hate the fabric or the style of a garment 
but don’t forget to check the buttons, trim, 
buckles, etc. They may be perfect for your next 
re-fashioning project!

• Size doesn’t always matter. Sometimes, a man’s 
extra large garment can give you enough material 
to re-shape and re-fashion into a fabulous garment 
for a smaller body.

• If you see something you like but aren’t sure what 
you’ll do with it, think about the consequences 
of purchasing it or leaving it. A cardinal rule of 
thrifting is, “buy it when you see it.” More than 
likely, it won’t be there the next time you go and 
thrift stores don’t give rainchecks. However, it’s 
very easy to overstock your sewing room with 
items that you “may fi nd a use for someday” so 
choose wisely!

There are lots of options when looking for design inspiration. These are 
just a few of the books available on the market right now. 

• Altered Clothing: Hip Fixes and Transformations with a Needle and Thread (Maggio)
• Exquisite Embellishments for Your Clothes (Shrader)
• Denim Redesign (Indygo Junction)
• Fashion DIY: 30 Ways to Create Your Own Style (Bladyes & Smith)
• Fashionology (Leisure Arts) 
• Generation T: 108 Ways to Transform a T-shirt (Nicolay)
• Subversive Seamster (Rannels, Alvarado, & Meng) 
• Sew Stylish: Easy-Sew Ideas for Customizing Clothes & Home Accessories (Ebben)
• Sew Subversive (Rannels, Alvarado, & Meng) 
• Sew Teen: Make Your Own Cool Clothes (Zent)
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I NEVER THOUGHT IT POSSIBLE
My interest in quilts was born out of my love for early and 
colonial American history. Being from Southeast Asia, I had 
not had much exposure to quilts because quilts are mainly 
a Western “thing.” Through reading, I became aware of and 
loved the look of Baltimore Album quilts, but still I didn’t 
catch the quilting bug because I didn’t know how to sew, 
nor did I have any interest in learning how. For a while, I was 
content just admiring quilts from afar.

Being
encouraged
by Barbara 
Herring, a 
great friend 
and a quilter 
of more than 
20 years, 
I decided 
to give 
quilting a 
try. I naively 
picked a 
somewhat
involved

pieced and appliquéd quilt for my fi rst project. But, under 
Barbara’s patient tutelage, I was able to complete the quilt 
as a gift to a nephew. I was thrilled about completing my fi rst 
quilt, and, before I knew it, I was making my second, third, 
and fourth…and to think I had never imagined myself sitting 
in front of a sewing machine actually sewing!

The beginning of my quilting journey in Fall 2005 also marked 
the start of my “BERNINA” journey in that I purchased my fi rst 
BERNINA machine not long after I started working on my fi rst 
quilt.

NEVER AGAIN!
That was my conclusion after straight-stitching some feather 
quilting on my third quilt! Oh, did I mention the frustration 
of having to turn the quilt with every other stitch in order to 
stitch the feathers? I had attempted free-motion quilting, but 
was not satisfi ed with the result. I didn’t think twice when I 
had the opportunity to purchase a machine with a BERNINA 
Stitch Regulator, thus further expanding my BERNINA con-
nection. Being equipped with the BSR (and armed with a bit 
of determination) has allowed me to absolutely enjoy quilting 
on wholecloth, free-hand feather quilting, and other free-
motion quilting projects.
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My First Quilt

NEVER SAYNEVER SAY NEVERNEVERNEVER SAY NEVER
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NEVER

NEVER SAY “NEVER”
That’s the conclusion I’ve reached on
my own, and it has become the motto
of my sewing journey.  Besides quilting,
my BERNINA machine has also allowed
me to enjoy machine embroidery and
heirloom sewing. Beyond my wildest
dreams, one of my quilts was published
in Creative Machine Embroidery in
Spring 2007. Since then my work has
been featured in Through the Needle
(“Pretty Pillow” in Issue 28) and several
quilting magazines. I was also thrilled
that my wholecloth interpretation of the
historical “Harrison Rose Urn” appliqué
block (circa 1860) won fi rst place in
the Grouseland Foundation’s 2008 Old
Tippecanoe Block Challenge. The block
is now part of a permanent collection at
the Grouseland Mansion, the home of
President William Harrison.

I have enjoyed passing on my
motto of “Never say ‘Never’” to
the students in my BSR-related
classes at my local BERNINA
dealership. With encouragement
and assurance, many who had
felt unsure about free-motion
quilting are now creating mas-
terpieces of their own. Seeing
their faces light up when they
discover the fun of free-motion
quilting and seeing how confi -
dent they have become in their
skills has been a deeply gratify-
ing experience.

Never say “Never”! I hope you have been encouraged by my sewing story and will
embark on your own exciting “Never say ‘Never’” sewing journey!

Ivory Spring Pieceful Garden
Song of Williamsburg

Wholecloth Quilt

Harrison Urn

QUILTING TIPS
Don’t just practice, make something. When you actually make something, you will put more
effort into the project! (I originally read this on Diane Gaudynski’s website and found it to be
very helpful.)

Use good quality threads – my favorites are YLI Silk and Aurifi l Make 50 cotton.

Begin with background quilting before tackling motifs like feather quilting when learning how
to free-motion quilt. Starting with background quilting techniques – echoing, stippling – will
help you get used to moving the quilt sandwich free-hand.

Try to incorporate something you have never done before in every quilt project. Your quilting
skills will be greatly enhanced over time, and you will be overcome your fear of trying
something new.

Look for repeated designs in fabrics to quilt for interesting special effects.

Originally from Southeast Asia, Wendy
trained and worked as a chemical
engineer and now resides in Northwest
Arkansas with her family. She teaches
BSR-related classes at Rogers Sewing
Center, her “sewing mother ship.” She
is a published quilter, and has been
featured in several quilting magazines.
Visit her at www.wendysheppard.net

This article is dedicated to Barbara
Herring, who introduced Wendy to the
wonderful world of quilting, and all the
dear ladies of the BERNINA Club at
Rogers Sewing Center.
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Hope, Love, and Peace HoodieHope, Love, and Peace Hoodie
Hooded sweatshirts with raw-edge appliqué are a popular trend. Some examples

combine screen printing with appliqué; others feature tone-on-tone effects by
using the same fabric for the appliqué. The hoodie is a great way to showcase
your creativity and ingenuity and have fun with fashion! There are no hard
rules in fashion anymore – it’s all about breaking the mold. Creating your
own hoodie design is an opportunity to push the limits while saving money.

There are many options for creating a raw-edge appliqué design. You
can use outline-style designs that are already available, create your own in

software, or use designs that you love to create an outline design as shown here.

Creating the Design
Open the software and insert the design.

Ungroup the
design so that
each color is a
separate piece.

Use Color Film to
delete all of the
colors except the
outline of the design.

Change the
outline stitch from
a satin stitch to
a single stitch.
This will be your
placement line.

Duplicate the
outline design.

Change the
color of the new
piece so that
the machine will
stop between
outlines.

Change the second color to a
triple stitch. This will hold the
appliqué fabrics in place.

Create any type of design
you like. That is the beauty of
making your own interpretation
– you can be as inventive as
you like, and it can’t be wrong!

BY ANNA HOGAN

Supplies
•  BERNINA Editor Plus V5 or Designer

Plus V5 Software

•  OESD pack Kaleidoscope Alphabet
#12149

• Large Oval Hoop

• Ultra Clean and Tear

• Isacord embroidery thread

•  80/12 Ballpoint Organ Embroidery
needle

• 101 Quilt Basting Spray

•  Ready-to-wear hoodie in desired
color

Hope, Love, and Peace HoodieHope, Love, and Peace Hoodie
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Finishing the Hoodie
Print out the templates for your designs. Cut around the design and 
cut two slits in the center of the template for ease of placement.

Place designs in a pleasing manner, then use a marking pen to 
trace the centering marks onto the hoodie.

Cut off the hoodie sleeve, leaving it long enough for a hem to make 
it the desired fi nished length.

Cut the individual designs or letters out of the templates to be used 
as patterns for the appliqué fabric, leaving at least 1/8" around the 
outline.

Spray the back of the pattern pieces with temporary spray adhesive 
such as 101 Quilt Basting Spray, and then place them on the fabric 
that was cut off of the sleeve. Cut out the appliqué shapes.

Align the centering 
marks you have 
drawn on the 
project with the 
center of the 
embroidery hoop.

Stitch out the fi rst 
color in a thread 
color matching the 
project.

Spray the back of 
the appliqué fabrics 
and place them 
over the stitched 
placement lines.

Stitch out the second color in the desired contrasting color.  

Try on the hoodie and mark the sleeve hems. Hem as desired. 
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CENTER EMBROIDERY
Cut a 13" x 17" rectangle for the pillow back from the silk dupioni and
set aside for the pillow back.

Hoop the remaining silk dupioni in the Mega Hoop with two layers of
Ultra Clean & Tear.

Select Design #19 from the Susanne Müller Library.

Select Mega Hoop with the hoop icon.

Select Endless Embroidery.

Select the minus option so that there are four repeats.

Turn off the reference points and press X to escape the screen.

With all of the motifs selected, press the Dupli-
cate Icon. Move the duplicated string of motifs
to the right side of the hoop.

Use Retrieve to delete all the motifs in column
1 (on the left). These exist as individual motifs,
and it will be more effi cient to move the col-
umns if they are all one object.

Press Duplicate again for a second column of
motifs.

Turn on the grid and move the columns so they
are directly across from each other. Space them
about 4 grid spaces apart for a 2" width apart.

BLACK
AND

WHITE
PILLOW

BY SUSAN FEARS

Black and white often indicate the most

formal of events, but can also create a

contemporary feel as well. Soften a bed

of white, update a dining room, or accent

leather furniture with this pillow. Combine

decorative stitches, trim, and embroidery

to form black stripes on white silk dupioni

while having fun with your new 830. Change

the colors to make this pillow fi t with any

décor and/or create a bolster using the

same patterns.

MATERIALS AND SUPPLIES
•  BERNINA 830 sewing & embroidery system
• ½ yard white silk dupioni for pillow front and back
• 11" Ultra Clean & Tear stabilizer
• Mega Hoop
• BERNINA Reverse Dual Feed Foot #1D
• BERNINA Open Embroidery Foot #20C
• BERNINA Edgestitch Dual Feed Foot #10D
• 1¼" x 14" double-eyelash trim
• Temporary or air-soluble marking pen
• ½ yd black embroidered ribbon, 5/8" wide
• Black Isacord embroidery thread
• Black 30-weight Mettler cotton embroidery thread
• Black 60-weight cotton thread (bobbin)
• White construction thread
• Organ 75S needle
• Microtex needle, size 90
• Pillow form, 12" x 16"

BERNINA 830 Project



To double-check the spacing, compare the width of
the single column (displayed when only one column
is highlighted) to the width of the total design (when
both are highlighted). For example, one column
should measure 18mm wide, and there are 2, so the
border of the design is 36mm. Subtract this amount
from the total width and the remaining space needs
to be wide enough for sewing the trim in place.

Turn on Single Color (the paintbrush) and embroider
the design.

CENTER TRIM
Unhoop the fabric and gently remove the stabilizer.

Trim the embellished section of the fabric to 13" x 17".
Set the remaining fabric aside for the pillow back.

Place the trim between the embroidered rows.

Attach Foot #1D or
#10D to the machine
and engage the
BERNINA Dual Feed.

Attach the trim using
the straight stitch and
BERNINA Dual Feed.

RIBBON EMBELLISHMENT
Measure 4" out from the center and draw a line with
the temporary ink pen.

Attach the ribbon us-
ing the BERNINA Dual
Feed and foot #1D
or #10D. Stitch along
both edges of the
ribbon.

 Select stitch #1114 from the 1100 Tassel Menu.

Attach Embroidery Foot #20C and set up machine
with 30-weight Black cotton embroidery thread and a
size 90 Microtex needle.

Draw a line to indicate the starting point for the
stitches. Place two layers of Ultra Clean & Tear under

the area to be stitched.

Align the edge of the
foot with the edge of
the ribbon; stitch.

Repeat for the other
side of the ribbon after
engaging Mirror Image.

The Tassel stitches
can be left as sewn for fl at tassels; trimmed straight

by cutting the needle threads; or
looped by cutting the bobbin
thread and pulling the tassel to the
front side. Do this after all the
embellishing is complete.

Repeat for the other half of the pillow.

STITCH COMBINATION
(Use the same thread set-up.)

Select stitch combi mode. Input new stitches #466 and #170.

Draw a sewing line 2¼"
from the center and mark
the starting point.

Place two layers of Ultra
Clean & Tear under the
stitching area and stitch
the pattern on the line.

Repeat for the other half of the pillow.

DECORATIVE TAPERING
(Use the same thread set-up.)

Select the 1400 Tapering menu. Select stitch #1402. Set the tapering
length to 50.

Draw a stitching
line 1¾" from the
ribbon and mark
the starting point.

Place two layers of
Ultra Clean & Tear
under the stitching
area and stitch the
pattern on the line.

Repeat for the other
half of the pillow.

PILLOW
ASSEMBLY
If desired, make
piping by covering
cord with bias-
cut strips of silk
dupioni. Match
the pillow cover or
the stitching. Sew
the optional piping to the outer edges of the 13" x 17" rectangle for the
pillow back.

Place the pillow back and front rectangles together with right sides facing.
Use a ½" seam allowance and stitch, leaving an opening for turning.

Turn right side out, insert the pillow form, and slipstitch the opening closed.
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T H R O U G H T H E N E E D L E

YLI Multi’s

YLI Jeans Stitch

YLI Pearl Crown Rayon

YLI Designer 6

YLI Candlelight

GUIDELINES:
1.  The center hole in Freemotion Couching Foot #43 must be comfortably fi lled so

that no matter which direction you stitch the needle will catch the cord being
couched.

2.  The cord must be soft and fl exible enough to move easily though the foot.

Choose a fi ller cord and additional threads for the loopers on the serger.  Some
possible fi ller cords are Jeans Stitch, Multi’s, Bunka, Pearl Crown Rayon, Designer 6,
Candlelight, and RibbonFloss. None of these fi ller threads used by themselves will
catch in every direction you sew. Each of these possible fi ller cords have different
diameters, so you must make sure the additional threads you add with the loopers
do not make the fi nished cord too large or too small to fl ow through Freemotion
Couching Foot #43 AND catch in every direction.

BY JANE GARRISON

Bernina’s Freemotion Couching Foot #43 is a 
wonderful, creative tool. Sometimes fi nding 
just the right color and size thread to couch 
can be a challenge but it’s easy to create the 
cord you want for your project using the 
cording foot on your serger. 

Jane Garrison, Director of Education for YLI Corp. began sewing at her
mother’s knee and has never stopped. She got her fi rst sewing machine
for her 5th birthday. She had lots of family mentors along the way who
encouraged her to make clothing, quilt, knit, and hand stitch. Jane briefl y
taught Home Economics and Science in the public school system in Florida
and North Carolina, owned a Bernina sewing machine dealership, designed
two pattern lines, and worked for Bernina of America before joining YLI
Corporation in 2005. Jane and her husband reside in York, SC.
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DIRECTIONS:
1.  Place the cording foot on your serger.

2.  Set your serger to the “rolled hem” setting.

3.  Thread the upper and lower looper with the
desired combination of threads to create the
type of fi nished cord you want to make. Jeans
Stitch, Fusions, 1000 denier Silk, Silk #30, Pearl
Crown Rayon, Designer 6, and Candlelight are
all good choices for the loopers. Don’t forget
that you can thread your loopers with more
than one thread – you can get a bit of sparkle
by adding Fine Metallic or Kaleidoscope to the
solid colors if you don’t want as much sparkle
as Candlelight will add.

4.  Use the right serger needle only; remove the left
needle. Thread the right needle with any sewing
thread that will match the threads in the looper.

5.  Set your stitch length between 3.5mm and
4mm and the differential feed to “N”.

6.  Place the fi ller cord in the cording foot and
serge. Try the fi nished cord in your #43 foot
and then alter the combination of threads if
necessary.

It may take a bit of experimentation to get the exact
color and size combination, but the mixes shown
here provide a starting place. Audition your threads
by twisting them together. The color of each one in
the mix does make a difference.

SergeSerge YOURYOUR

OWNOWN Custom  Custom  
    Cords    Cords

Serge YOUR

OWN Custom  
    Cords

Pearl Crown RayonPearl Crown Rayon
fi ller cord; Candlelight infi ller cord; Candlelight in

both loopersboth loopers

Multi’s fi ller cord;Multi’s fi ller cord;
Candlelight in bothCandlelight in both

loopersloopers

Pearl Crown Rayon fi ller cord;Pearl Crown Rayon fi ller cord;
Pearl Crown Rayon andPearl Crown Rayon and
Jeans Stitch in loopersJeans Stitch in loopers

Pearl Crown Rayon fi llerPearl Crown Rayon fi ller
cord; Jeans Stitch andcord; Jeans Stitch and
Candlelight in loopersCandlelight in loopers

Pearl Crown Rayon fi llerPearl Crown Rayon fi ller
cord; Pearl Crown Rayon andcord; Pearl Crown Rayon and

Candlelight in loopersCandlelight in loopers
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MATERIALS
• Benartex “City Girl” fl oral fabric
• Benartex “City Girl” striped fabric
•  Purple fabric remnant for the ruffl ed

embellishment
•  OESD HeavyWeight Cut-Away stabilizer
• 101 Quilt Basting Spray
• Ruffl er #86
• Clear Foot #34/34C
• Eyelet Embroidery Attachment #83
•  Square or rectangular woven basket, at least

8" x 8"
CUTTING OUT
•  Purple fabric: Approximately 3 yards of 1"

wide bias-cut strips
• Striped fabric:

 - Two 7¾" x 8" rectangles
 -  Four fabric strips, each 1" x 16" for

ribbons that fi nish to ¼" wide

A gift of fl owers lasts even longer when
presented in this lovely decorated basket.
Insert a greeting card or note into the
pocket to express your sentiments. The
large embroidered eyelets in the corners
are easily stitched using the Eyelet
Embroidery Attachment #83.

This project was originally published by BERNINA
International in Inspiration magazine, No. 43, Spring 2009

INSTRUCTIONS
All seam allowances are ½".

Pleat the purple fabric strips with the ruffl er. Trim
strips to 3/8" wide, centering the stitching. TIP:
Use a rotary cutter and clear ruler to trim the strips.

Select – but do not cut out – a large purple fl ower from the City Girls
fabric and bond a layer of HeavyWeight Cut-Away stabilizer to the wrong
side using 101 Quilt Basting Spray. Stitch the ruffl ed strips to the fl ower,
petal by petal.

Cut a 73/8” x 8" rectangle from the ruffl e-embellished fabric, centering the
fl ower in the rectangle. Trim the seam allowances from the stabilizer. Make
a narrow double hem at the upper edge of the rectangle.

Place the fi nished fl ower rectangle face up on the right side of one 7¾"
x 8" rectangle of fabric, lower edges fl ush. Place the second 7¾" x 8"
rectangle right side down on top. Stitch around the rectangle through all
layers, leaving an opening in one side for turning.

Turn the pocket right side out and press. Topstitch ¼" from all edges.

Make eyelets in the pocket corners following the instructions included with
the Eyelet Embroidery Set.

To make the ribbons, fold and press the fabric strips in half lengthwise with
wrong sides facing. Turn the raw edges in to the fold and press. Edge-
stitch along both folded edges. Attach pocket to basket by tying ribbons
through the eyelets.

Finished size: 7¼" x 7½"Finished size: 7¼" x 7½"

Flower PowerFlower Power
EMBELLISHED BASKETEMBELLISHED BASKET
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Prepare the Can
Carefully cut the can open with tin snips, slitting it down the side to open it fl at. The cut 
edges are very sharp and may have burrs; fi le the edges before handling.

Position the open can on Stabil Stick before doing anything else. (The rotary blade won’t cut through 
the aluminum without the Stabil Stick.) Cut quilt block pieces – minus seam allowances – as desired.

Embroider on 
  the Unusual
Part 1: Aluminum Drink Cans Hot Pad

You can 
embroider 
on almost 
anything – 
wood, foil, 
mesh, plastic 
– even 
on your 
recyclable 
drink cans! 

Gather the Supplies
• Drink cans
• Tin snips
• Metal fi le
• Embroidery hoop 
• Stabil Stick stabilizer
• 80/12 Sharp needle
• Embroidery designs, such as Studio 

BERNINA Quilting from the Heart 
collection #858
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Prepare the Embroidery
In BERNINA Embroidery Software, draw placement lines for each shape. Add pattern run
stitches for crazy quilting, avoiding heavy satin stitch patterns. Open stitches – such as
feather stitch variations – work best.

Add embroidery last. The embroidery must stitch after the pieces are stitched together.
Select designs with a straight-stitch outline. Reduce satin and fi ll density to 85% or less. The
sample shown uses motifs from Studio BERNINA Quilting from the Heart collection #858.

Embroider the Can
Insert a size 80/12 Sharp needle into the embroidery system. Thread with
Isacord embroidery thread.

Hoop a layer of Stabil Stick and remove the paper backing. Stitch the
placement lines. Position the cut can pieces on the stabilizer, smoothing
them fi rmly onto the adhesive. Stitch the pattern run stitches, keeping the
can pieces butted together while stitching.

Continue stitching until
all pieces are joined.
Stitch the embroidery
designs.

When embroidery is
complete, remove the
hoop from machine
and carefully clean the
hook area. Remove
block from hoop; trim
away excess stabilizer.

Construct the Hot Pad
Add borders as desired. Cut the batting 1” larger than the trimmed
patchwork block. Cut the backing 1” larger than the batting.

Center the batting on the wrong side of
the backing. Center the

patchwork block on the
batting.

Stitch in the border ditch
with a blanket stitch and
Clear Embroidery Foot
#39/39C. Wrap the excess
backing to the front and
secure with a blanket stitch
and Clear Embroidery Foot
#39/39C.

Watch future issues for more
Embroidery on the Unusual!

Resources
• Machine Embroidery Wild & Wacky:

Stitch on Any and Every Surface
by Linda Turner Geiepentrog and
Rebecca Kamp Brent

• Creative Recycling in Embroidery
by Val Holmes
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BY DEBBI LASHBROOK

My Label 3D Fashion
 Pattern Software

10Reasons
you LOVE

1.  You get great fi t in a variety of garment styles that are adjusted

to your unique body measurements.

2.  You can visualize the styles on your bodies by seeing them on

your three-dimensional body doubles.

3.  You have the ability to adjust style properties to create your

own pattern styles.

4.  You have built-in help on measuring, fi tting, and adjusting the

styles to fi t your unique body types.

5.  You have a measurement kit that contains all the essentials for

accurate measuring, including a measuring slide show.

6.  You can view presser feet videos for garment sewing to make

your garment construction easier and more professional.

7.  You have built-in garment sewing instructions, including

illustrated techniques.

8.  You have the ability to add embellishments - stitches,

embroidery, and buttons - and have positioning marks printed

on your paper patterns.

9.  You have continuing education through webinars covering

special topics.

10.  You have access to instructional videos at

 www.berninausa.com on using the software.

NEW 5 Pocket Jeans pattern available for downloading at www.berninamylabel.com!
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Directional
DELIGHT!DELIGHT!

Stitch Recipe:
830830

BY JILL BRALEY

With the 830, this stitch recipe is sewn completely in one direction,

with no pivoting or realignment. What makes the 830 directional

stitching stand out from that of previous models? The connecting

stitch screen – there’s no longer any need to fi gure out the movement

using a compass, as the 830 determines it for you based on the stitch

arrangement you create in the connecting stitch screen! What could

be easier?

830 Supplies
•  Sideways Motion Foot #40C

•  Needle appropriate for
thread selected
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4-  Instead of pivoting and rotating your
stitches manually, the 830 offers NEW
functionality. It’s able to rotate a large
variety of stitches in 360 different
directions!

3- Gather another stitch, #439. Select the
new Multi-Directional Sewing icon.

2- Gather stitches - #761, one of 261
new stitches found on the 830!

1- Open Combi Mode.

5- Rotate the stitch pattern in direction
270°; confi rm the changes by touching
the green checkmark ( ).

6-  The combination is beginning to
come together, but there is even
more that can be done to line up the
complete combination just the way
you want it.

7-  Touch the Multifunction icon (eye-
glasses) to preview the combination
as it will sew out. The 830 offers yet
one more new exciting feature with the
new Connecting Stitches icon.

8-  In the Connecting Stitches screen,
use your fi nger or touch pen to “drag
and drop” your stitches to the perfect
location to sew exactly what you
envision.

9-  Here is the adjusted combination.
Look in the far left preview screen;
notice that the stitches will not sew
out in a continuous straight line. Let’s
make one more adjustment.

10-  The Connecting Stitches screen
enables you to move single motifs
or groups of motifs. The group was
moved to create a straight row of
continuous stitching on the left.
Confi rm your creation by touching
the green checkmark ( ).

11- Preview screen. Touch the red X
to leave the active screen and return to
Combi Mode.

12-  Combi Mode screen and you are
ready to sew! Touch Pattern Begin;
attach Sideways Motion Foot #40C;
stitch your creation. No pivots or
rotations are necessary – the 830
moves and feeds the fabric for you!
All you do is simply guide the work.

MANUAL SEWING INSTRUCTIONS FOR OTHER MODELS
Technique
Attach Clear Foot #34/34C. Select artista stitch #740 or other scallop stitch. Sew the fi rst pass.

Attach Open Embroidery Foot #20/20C. Select artista stitch 439 or other diamond-shaped
stitch. Engage the Single Pattern function and the Securing function.

Line up the beginning of the stitch as shown in
the photo and sew the pattern perpendicular to
the fi rst row of stitching. Repeat as desired.

 Supplies
 • Clear Foot #34/34C

 •  Open Embroidery Foot #20/20C

 •  Needle appropriate for thread
selected

 •  Marking tools
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Design
Open software. Right click on the hoop icon; select
the Large Oval (255 x 145) hoop and Manual
centering. Right click on the grid icon; select Show
Grid and Snap to Grid.

Click on the Rectangle tool; select Fill = Blackwork
Fill. Click and drag to draw a 4 x 4 cm square in the
top left area of the hoop.

Right click & drag on the fi rst square to clone a
second square directly under the fi rst one. Repeat
two more times for a total of four stacked squares.

Double click on
the fi rst square
to open Object
Properties. Select
the Fill Stitch
tab; click on the
Select button.
Scroll through
the blackwork
fi ll stitches and

select one for the fi rst section of your bookmark (the
sample uses B0034a). Click OK.

Repeat for
the remaining
squares (B0024a,
B0035a, and
B0015a were
used in the
sample).

Select all four
squares; click on
the Group icon to group them into a single unit.

Deselect the squares by clicking on an empty area
of the screen. Select Color 2. Select the Open
Object tool; select Outline = Satin Stitch. Draw a line
between the fi rst
two squares.

Right click on
the line to open
Object Properties;
select the Outline
Stitch tab.
Change Satin
Width to 0.07
inches.

Right click and
drag the line to
clone it; place the
clone between the
second and third
squares. Repeat
and place a third
line between the
third and fourth squares.
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These fancywork bookmarks
make great last-minute gifts. Keep
one or two for yourself – maybe you’ll fi nd
time to relax and read a book!
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Select the Rectangle tool; select Outline = Satin Stitch. Click
and drag to draw a rectangle around all four squares.

Select Arrange > Add Buttonhole; click just below the
center of the top of the bookmark.

Right click on the
buttonhole to open Object
Properties. Change Slit
Length to 0.02 inches.

Reposition buttonhole
near edge of bookmark if
needed.

Select all parts of the
bookmark, then click on the Group icon to group them into a
single unit.

Select File > Card/Machine Write to send the design to your
embroidery system or a BERNINA Memory Stick.

Embroidery
Adhere a layer of AquaMesh Plus to the back of the linen;
hoop in the Large Oval hoop.

Thread the embroidery system with black embroidery thread
in the needle and bobbin. Do not adjust tensions! Since the
bookmarks are reversible, use balanced thread tensions so
the stitches look the same on the back and front.

Embroider; remove from hoop.

Finishing
Using the rotary cutter, ruler,
and mat, trim excess linen
from around bookmarks,
leaving about ¼" of fabric
beyond the stitching.

Fringe edges.

Use a buttonhole cutter and
block to cut the slit in the
buttonhole.

Soak overnight to remove
water-soluble stabilizer. Blot
excess water, then air dry.

Use a tapestry needle to insert the ribbon. Knot the ribbon.

• White linen, large enough to hoop
•  Black embroidery thread for needle

and bobbin
•  BERNINA v5 DesignerPlus software

with blackwork fi lls

•  OESD Blackwork 1 Collection
(Pack 11531), optional

•  Water-soluble stabilizer such as
AquaMesh Plus

• Large Oval Hoop

• Rotary cutter and mat
•  Nifty Notions “Cut for the Cure” ruler,

4" x 14"
• Buttonhole cutter and block
• 12" length of narrow ribbon

Materials and Supplies

Variation
Substitute designs from OESD’s
Blackwork 1 collection (Pack 11531)
for any or all of the blackwork fi ll
squares. Some of these designs are
also found in v5 software in C > My
Designs > Red Blackwork.

Right click and drag on the fi rst
bookmark to create a clone; place it at the right side of the hoop.

With the cloned bookmark selected, click on the Ungroup icon to
break the pieces apart. Select and delete the second and fourth
squares.

Select File > Insert Design. Select Nx428 and click Open. Position
in the second square. Repeat, placing Nx437 in the fourth square.

Click on the Color Film icon; notice that the new
designs are Color 15. Right click on the black
15 icon to select
the new areas of

the bookmark; change Color 15 to
Color 1.

Drag and drop Color 1 onto Color 1,
and Color 2 onto Color 2.

Select File > Card/Machine Write to
send the design to your embroidery
system or a BERNINA Memory Stick.
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Have you heard the buzz about BERNINA’s My
Label 3D Fashion Pattern Software? Now you can
create unique, well-fi tting garments that refl ect your
taste, your interests and your body. It’s easy to get
started using the My Label Software with our My
Label Instructional Videos. Learn step-by-step how
to navigate the My Label Software with seventeen
instructional mini videos. From start to fi nish, these
videos will assist you in creating well-fi tting patterns
like a pro! Go to: www.berninausa.com > Learn It >
My Label Classes

Attention My Label owners! A new Five-Pocket Jeans Pattern is
now available as a FREE download. Go to: www.berninamylabel.com > Free Download

Projects! Projects! Projects! Visit
www.berninausa.com to download FREE projects and
lessons. New projects are posted frequently!  Whether
you are new to sewing or a sewer looking for
a challenge, we have FREE
projects to inspire you
as well as teach you
a few new tricks! The
latest are Embroidered
Silk Quilt, Learn-to-
Sew-Ruffl es, Decorative
Effects with Explorations
Software, Serger Log
Cabin Table Topper, Quick
on Your Feet, Boo Boo
Bunny and more!

Go to: www.berninausa.com
> Make It > Projects > Project
title

BERNINA BLOG
If you haven’t joined the BERNINA
Blog, it’s never too late! Visit us
at www.berninausablog.com for
sewing tips and tricks, projects,
news, and inspiration. Even if
you don’t yet own a BERNINA
sewing machine, serger, or
software, you’ll fi nd useful
information for all of your

sewing adventures.






